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1. Dulezité

Tato elektronickd uZivatelskd prirucka je
ur¢ena pro kazdého uZivatele tohoto monitoru
Philips. Pred pouZzivdnim monitoru si prectéte
tuto uzivatelskou prirucku. Obsahuje dilezité
informace a poznamky k pouzivani vaseho
monitoru.

Zaruka Philips je platnd, pokud je vyrobek
pouzivdn pro navrzenou potrebu v souladu

s ndvodem a po priloZen( origindlu faktury
nebo pokladnim dokladem, oznacujicim datum
ndkupu, jméno prodejce a modelové a vyrobnf
¢islo vyrobku.

1.1 Bezpecnostni opatreni a udrzba

0 Varovani

Pouziti kontrol, Uprav nebo postupl jinym

zpUsobem nez je stanoveno v této dokumentaci

muZze vést k ohroZenf Sokem, elektrickym a/

nebo mechanickym rizikim.

Prectéte si a dodrzujte tyto instrukce pri

zapojovani a pouzivdnf vaseho PC monitoru.

Pouzivani

»  Udrzujte monitor mimo primé slunecnf
zérenf a v bezpecné vzdélenosti od
veskerych zdroju tepla.

»  Odstrarite veskeré predméty, které by
mohly spadnout do vétracich otvord nebo

zabranit dostatecnému chlazeni elektroniky
monitoru.

*  Nezakryvejte vétracl otvory ve skffice.

*  Umlistéte monitor na takové misto, ze
kterého bude elektrickd zdstrcka a zdsuvka
snadno pristupna.

* Jestlize jste vypnuli monitor odpojenim
napdjectho kabelu nebo kabelu napdjeciho
adaptéru, pred pripojenim kabelu pockejte
6 sekund, aby monitor fungoval normdiné.

»  Vzdy pouzivejte napdjeci kabel schvaleny
spolecnostf Philips. Pokud napd jeci kabel
chybi, obrat'te se na nejblizsf servisni

stredisko. (Viz informace o strediscich
zdkaznické péce)

*  Béhem pouZivdni nevystavujte monitor
nadmémym otresim nebo ndrazim.

*  Pri pouzivani nebo premistovdni do mo-
nitoru nekopejte a zabrarite pripadnému
padu.

Udrzba

*  Aby byl monitor chrdnén pred moznym
poskozenim, nevyvijejte na panel LCD
nadmeémy tlak. Pri premistovani zvedejte
monitor za rdm; pri zveddni monitoru
nesahejte rukou nebo prsty na panel LCD.

* Nebudete-li monitor delsf dobu pouZzivat,
odpojte jej ze zasuvky.

* Pred ociSténim mime navihéenym
hadrfkem monitor odpojte ze zdsuvky.
Je-li vypnuté napdjeni, Ize obrazovku otrit
suchym hadrikem. K ¢isténi monitoru nikdy
nepouzivejte organicka rozpoustédla, jako
napriklad alkohol nebo Cisti¢e s obsahem
¢pavku.

» Zabrarite nebezped( Urazu elektrickym
proudem nebo trvalého poskozenf
monitoru a chrarite monitor pried prachem,
destém, vodou nebo nadmérmé vihkym
prostredim.

* Pokud dojde k namoceni monitoru, co
nejdrive jej osuste suchym hadrikem.

* Vnikne-li do monitoru cizf ldtka nebo voda,
ihned vypnéte napdjeni a odpojte napdjecl
kabel. Odstrarite ciz ldtku nebo vodu
z monitoru a odeslete jej do servisniho
strediska.

*  Monitor neskladujte ani nepouZzivejte
na mistech vystavenych teplu, pfimému
slunecnimu zdreni nebo extrémnim
teplotdm.

*  Chcete-li zachovat optimdlni vykonnost
monitoru a prodlouZit jeho Zivotnost,
pouzivejte jej na mist&, které splfiuje
ndsledujici rozsahy teplot a vihkosti.

o Teplota: 0-40°C 32-95°F
o Vlhkost: 20-80% relativni vihkosti



1. Dilezite

« DULEZITE: Ped ponechanim monitoru
bez dozoru vzdy aktivujte sporic obrazovky.
Bude-li na vaSem monitoru zobrazen
nemeénici se staticky obsah, vzdy aktivujte
aplikaci pro pravidelnou obnovu obrazovky.
Dlouhodobé neprerusované zobrazenf
nehybného nebo statického obrazu mdze
zpUsobit ,,vypdleni* obrazovky, rovnéz
zndmé jako ,,dosvit" nebo ,,zobrazenf
duchud.

., Vypdlen*, , dosvit" nebo ,zobrazenf
duchd" je dobre zndmy jev u technologie
panelt LCD. V mnoha pripadech ,,vypdleni*,
,,dosvit"* nebo ,,zobrazenf duchl* postupné
zmizf po urité dobé mimo provoz.

D Vystraha

Vézné priznaky , vypédleni",, dosvitu" nebo
,zobrazenf duch(" nezmizi a nelze je opravit. Na
vySe uvedené poskozen( se nevztahuje zdruka.

Servis

e Kryt pldsté mize otevrit pouze kvalifikovany
servisni pracovnik.

* Pokud je pro opravu vyzadovédna
dokumentace nebo integrace, obratte se
na nejblizsi servisni stredisko. (Viz kapitola
,,Stredisko zdkaznické péce™)

* Informace o prevézenf najdete v Casti
,, Technické Udaje".

*  Neponechdvejte monitor v auté nebo v
zavazadlovém prostoru auta na primém
slunci.

€& Pozniamka

Pokud monitor nefunguje spravné nebo pokud
si nejste jisti, jaké kroky je treba provést po
provedeni pokynu v této prirucce, obrat'te se na
servisniho pracovnika.

1.2 Vysvétleni zapisu

Nasledujici pododdily popisujf zplsob zdpisu,
ktery se pouzivd v této prirucce.

Poznamky, upozornéni a vystrahy

Na strdnkdch této prirucky mizete narazit na
text, ktery je opatfeny symbolem a je vytistén
tucné nebo kurzivou. Takové useky obsahujf
pozndmky, upozornéni a vystrahy. Jejich pouzitf
je nasledujict:

© Poznamka

Tento symbol oznacuje dllezité informace a
ndvrhy, které poméhajf Iépe vyuzit pocitacovy
systém.

© Upozornéni

Tento symbol oznacuje informace, které
objastiuji, jak se vyhnout moZnému poskozen(
zaf{zen( nebo ztrdté dat.

) Vystraha

Tento symbol oznacuje nebezped( télesného
ubliZzenf a vysvétluje, jak se danému problému
vyhnout.

Nekteré vystrahy se mohou objevit v rizné
podobé a nemusf byt uvozeny symbolem.V
takovém pripade je konkrétni vyznacenf vystrahy
nar{zeno Uradem pro regulaci.



1.3 Likvidace produktu a obalového
materialu

Likvidace elektrickych a elektronickych zarize-
ni - WEEE

This marking on the product or on its
packaging illustrates that, under European
Directive 2002/96/EC governing used electrical
and electronic appliances, this product may
not be disposed of with normal household
waste.You are responsible for disposal of

this equipment through a designated waste
electrical and electronic equipment collection.
To determine the locations for dropping off
such waste electrical and electronic, contact
your local government office, the waste disposal
organization that serves your household or the
store at which you purchased the product.

Your new monitor contains materials that can
be recycled and reused. Specialized companies
can recycle your product to increase the
amount of reusable materials and to minimize
the amount to be disposed of.

All redundant packing material has been
omitted. We have done our utmost to make the
packaging easily separable into mono materials.
Please find out about the local regulations on
how to dispose of your old monitor and packing
from your sales representative.

Recycling Information for Customers

Your display is manufactured with high quality
materials and components which can be
recycled and reused.

To learn more about our recycling program
please visit www.philips.com/about/sustainability/
recycling,




2. Sestaveni monitoru 2] Namontujte stojanek podstavce
: 1. Umistéte monitor obrazovkou dold na

meékky a hladky podklad, aby nedoslo k
poskrdbdni obrazovky.

2.1 Instalace

El Obsah krabice

Start

PHILIPS

2. Uchopte stojanek podstavce obéma
rukama a pevné zasurite do sloupku
podstavce.

(1) Opatmeé pripevnéte podstavec ke
sloupku podstavce tak, aby zdpadka
zajistila podstavec.

(2) Prsty utdhnéte Sroub na spodnf strané
podstavce a pevneé zajistéte podstavec
ke sloupku.

VGA (nepovinny) DVI (nepovinny)




Bl Pripojeni k pogitadi
Model 227E3L:

PHILIPS

(1] Vstup stidavého napdjenf
Vstup VGA
Vstup DVI-D
Zamek proti krddezi Kensington

Model 227E3LH:

PHILIPS

(1] Vstup stridavého napdjenf
O \stupVGA
Vstup DVI-D
Vstup HDMI
Vstup zvuku
Vystup zvuku
Zamek proti krddezi Kensington

Model 227E3LPH:

PHILIPS

o 000
rﬂm C’:Q?Q
o Efﬂg

(1] Vstup stfidavého napdjenf

Vstup VGA
Vstup DVI-D

O \stup HOMI

Vystup zvuku HDMI
Zamek proti krddezi Kensington

Pripojeni k pocitaci

1.

Pevné pripojte napdjeci kabel k zadnf strané
monitoru.

Vypnéte pocitac a odpojte jeho napdjeci
kabel.

Pripojte signdlovy kabel monitoru do video
konektoru na zadni strané pocitace.
Zapojte napdjeci kabel pocitace a monitoru
do nejblizsi zdsuvky.

Zapnéte pocita¢ a monitor: Jestlize se

na monitoru objevi obraz, instalace je
dokoncena.



2.2 Ovladani monitoru

PHILPS

a Popis vyrobku z celniho pohledu
Model 227E3L:

Model 227E3LH:

(5]
/v /A 17/4 /0K [0}
| | [\ | |
(7] (6] ©O ©6 0 o
o o [Sourk ZAPNUTI aVYPNUT(
napajeni monitoru.
Slouzi ke vstupu do nabidky
Slouzi k ndvratu na predchozf
o < droveri OSD.
o iq Slouzi k dpravé nastaven(
hlasitosti reproduktoru.
© | A V¥V [Sloui k Upravdm nabidky OSD.
Slouzi ke zméné zdroje
6 ©® vstupniho signdlu.
Smartimage Lite Lze vybrat
néktery ze Sesti rezimd: Standard
o @ (Standardni), Internet a Game
(Hra).

Model 227E3LPH:

(54

/v /A SENSOR/ < /0K [0)

| | [\ | |
7] (¢} o e o (1]

Slouz k ZAPNUTI aVYPNUT(

/e\
@/v /A /4 /0K [0)

I I [\ | |
(7] (6] o O (2] o
o o [Sourk ZAPNUT( aVYPNUT(
napajeni monitoru.

Slouzi ke vstupu do nabidky
© 2/0K o
Slouzi k ndvratu na predchozf
© < drovert OSD.
O | [ [Slous ke zméné na zobrazeni 4:3.
© A V [Slouzi k dpravdm nabidky OSD.
Slouzi ke zméné zdroje
60 © vstupniho signalu.
Smartlmage Lite Lze vybrat
néktery ze Sesti rezimd: Standard
o @ (Standardni), Internet a Game
(Hra).

I
o O napajeni monitoru.
Slouzi ke vstupu do nabidky
Slouzi k ndvratu na predchozf
o < drovers OSD.
Slouzi k nastaven( drovné
@ | SENSOR [snimace pro automatické
ovladani podsvicent.
© | A V¥V [SlouZi k Upravém nabidky OSD.
Slouzi ke zméné zdroje
6 9 vstupniho signdlu.
Smartlmage Lite Lze vybrat
néktery ze Sesti rezimd: Standard
o @ (Standardni), Internet a Game
(Hra).




2. Sestaveni monito
2] Popis zobrazeni funkci na obrazovce

Co je nabidka na obrazovce (OSD)?

Funkci nabidky obrazovky (On-Screen Display,
OSD) jsou vybaveny viechny monitory

LCD Philips. Umozriuje koncovému uzivateli
upravovat vlastnosti obrazovky nebo vybirat
funkce monitoru prfmo prostrednictvim
zobrazeného okna s pokyny. NiZe je uveden
priklad prfjlemného rozhrani obrazovky:

Model 227E3L:

Model 227E3LPH:

Zakladni a jednoduché pokyny k ovladacim
tladitkim

Ve vySe uvedené nabidce obrazovky OSD
muZete stisknutim tlacftek ¥ A na prednim
rdmecku monitoru pohybovat kurzorem a
stisknutimOK potvrdit vybér nebo zménu.

Nabidka OSD

Nize je uveden celkovy pohled na strukturu
OSD. Tento prehled mlzete vyuzit, budete-li
chtit pozdéji prozkoumat rliznd nastavent.

Main menu Sub menu
Power Sensor |: On — 04
Off

(available for selective models)

— VGA
Input

— DVI (available for selective models)

L— HDMI (available for selective models)

r— Picture Format — Wide Screen, 4:3
Picture

— Brightness — 0~100

— Contrast — 0~100

— SmartResponse — On, Off (available for selective models)

—— SmartContrast — On, Off

r— Volume — 0~100 (available for selective models)
Audio

— Stand Alone — On, Off

— Mute — On, Off

— Color Temperature — 6500K, 9300K
Color

— sRGB

— User Define Red: 0~100

E Green: 0~100
Blue: 0~100

Language — English, Espafiol, Frangais, Deutsch, ltaliano,

Portugués, Pycckuit, &AL, Tirkge

r— Horizontal — 0~100
OSD Settings
— Vertical — 0~100
— Transparency — Off1,2,3,4
— OSD Time out — 5,10,20, 30, 60
Setup — Auto
— Power LED — 0,1,2,3,4
— Over Scan — On, Off (available for selective models)
— H. Position — 0~100
— V. Position — 0~100
[ Phase — 0~100
— Clock — 0~100
F— Resolution Notification — On, Off
— Reset — Yes, No
L— Information




El Poznimka k rozligeni

Tento monitor je urcen pro optimdini vykon
pri nativnim rozliseni 1920 x 1080 pri 60 Hz.
Kdyz je monitor zapnut pri jiném rozlisenf, na
obrazovce se zobrazi vystraha: Pro optimalni
vysledek pouzijte rozliseni 1920 x 1080 pri 60
Hz.

Zobrazovan( vystrahy na nativnf rozlisenf Ize
vypnout v ¢asti Nastaven( v nabidce OSD.

Bl Fyzické funkce
Naklon

2.3 Odpojte stojanek podstavce a
podstavec

Bl Demontaz stojanku podstavce

Nez zacnete demontovat podstavec monitoru,

postupujte podle pokynt nize, aby se zabranilo

jakémukoli moznému poskozeni nebo zranént.

1. Umistéte monitor obrazovkou doli na
mekky podklad, aby nedoslo k poskrdbdnf
obrazovky.

2. Podle nésledujicich pokyn( oddélte stojanek
podstavce od sloupku podstavce:

(1) Prsty uvolnéte Sroub na spodnf strané
podstavce.

(2) Opatrmnymi pohyby nahoru a dold
uvolnéte zdpadku, kterd zajistuje
podstavec, a stdhnéte podstavec ze
sloupku.




E Demontaz podstavce

1. Mdzete zasunout plochy Sroubovdk do
dvou uvolfiovacl otvord na krytu zavésu a
jemnym pacenim jej odstrarite.

2. Odmontujte 4 Srouby a potom sejméte
podstavec z monitoru.




3. Optimalizace Obrazu

3.1 Smartimage Lite

E Cojeto?

Funkce Smartimage Lite nabizi scéndre, které
optimalizujf zobrazenf rdznych typd obsahu a
dynamicky zlepsuje jas, kontrast, barvy a ostrost
v redlném case. Funkce Philips Smartimage Lite
prindsi optimalizované zobrazeni monitoru

bez ohledu na to, zda pracujete s aplikacemi,
prohlizite obrdzky nebo sledujete video.

Bl Prog to potfebuii?

Protoze chcete sledovat monitor, ktery

prindsi optimalizované zobrazen( viech vasich
oblibenych typl obsahu. Software Smartimage
Lite dynamicky upravuje jas, kontrast, barvy a
ostrost v redlném case pro dosazen( nejlepsiho
zdzitku ze sledovani monitoru.

E Jak to funguje?

Smartlmage Lite exkluzivni Spickova technologie
spolecnosti Philips, kterd analyzuje obsah
zobrazeny na obrazovce. Na zdkladé védmi
zvoleného scéndre technologie Smartimage

Lite dynamicky zlepsuje kontrast, sytost barev

a ostrost obrazu pro vylepseni zobrazovaného
obsahu — vSe v redlném case stisknutim jediného
tladitka.

B Jak aktivovat Smartlmage Lite?

&

1. Stisknutim B se Smartlmage Lite zobrazi
na obrazovce;

2. Opakovanym stisknutim BI? mGzete prepinat
mezi rezimy Standard (Standardni), Internet,
Game (Hra).
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3. Zobrazeni Smartlmage Lite zUstane na
obrazovce po dobu 5 sekund nebo mUzete
rovnéz potvrdit stisknutim tlacitka OK.

4. Po aktivaci technologie Smartimage Lite je

automaticky deaktivovdno schéma sRGB.
Aby bylo mozné pouzit schéma sRGB, je
treba deaktivovat funkci Smartlmage Lite
stisknutim tlacftka B2 na prednim panelu
monitoru.
Kromé tlacitka BJ? pro posun doli mizete
rovnéz provést vybér stisknutim tlacitek w a
, potvrdit vybér stisknutim tlacitka OK a ukondcit
nabidku Smartimage Lite OSD.
Lze vybrat néktery ze Sesti rezimu: Standard
(Standardni), Internet, Game (Hra).

@ Smartlmage "™

Standard

Internet

*  Standard (Standardni): Vylepsuje text a
snizuje jas pro zvysenf ¢itelnosti a omezen(
namahdni zraku. Tento rezim podstatné
zvysuje Citelnost a produktivitu pri prdci
s tabulkami, soubory PDF, skenovanymi
¢lanky nebo jinymi obecnymi kanceldrskymi
aplikacemi.

*  Internet: Tento profil kombinuje vylepsenf
sytosti barev, dynamického kontrastu a
ostrosti pro zobrazenf fotografif a dalsich
obrdzkd s vynikajici Cistotou v Zivych
barvdch — to vse bez artefaktd a vybledlych
barev.

*  Game (Hra): Tento profil prindsi nejlepsf
hemf z&Zitek pro hrdce, protoze aktivuje
prebuzeny okruh pro optimalni dobu
odezvy, omezeni zubatych okrajd rychle
se pohybujicich objektd na obrazovce a
vylepsen( kontrastniho poméru pro jasné a
tmavé scény.




3.2 SmartContrast

E Cojeto?

Jedine¢nd technologie, kterd dynamicky analyzuje
zobrazeny obsah a automaticky optimalizuje
kontrastni pomér monitoru LCD pro maximdlnf
vizudinf Cistotu a pozitek ze sledovéni. Zvysuje
podsvicen( pro jasnéjsi, ostrejsi a jasn&jsi obraz
nebo snhizuje podsviceni pro jasné zobrazenf
obrazu s tmavym pozadim.

Bl Pro¢ to potfebuii?

Zédate nejvy3i vizudlni gistotu a pohodli
sledovan( jakéhokoli typu obsahu. SmartContrast
dynamicky r{df kontrast a upravuje podsvicenf
pro jasné, ostré a jasné zobrazenf her a videa
nebo pro zobrazenf jasného, citelného textu
pro kancelarskou praci. Omezenim spotreby
monitoru Setrfte ndklady a prodluzujete Zivot
vaseho monitoru.

E Jak to funguje?

Po aktivaci bude funkce SmartContrast v
redlném case analyzovat zobrazeny obsah a
upravovat barvy a ridit intenzitu podsvicenf. Tato
funkce bude dynamicky vylepSovat kontrast pro
skvély zazitek pri prohlizenf fotografif nebo hrani
her.

3.3 Philips SmartControl Lite

Novy software SmartControl Lite od
spole¢nosti Phillips umozriuje ovlddat monitor
prostrednictvim snadno pouzitelného grafického
rozhrani na obrazovce. Slozitd nastaven( jsou
minulostf, protoZe tento uzivatelsky prijemny
software vds provede jemnym vyladénim
rozlidenf, kalibraci barev, nastavenim frekvence/
fdze, nastavenim bilého bodu RGB atd.

Tento software zalozeny na pritazlivych
animovanych ikondch kompatibilni se systémem
Windows 7, ktery je vybaven nejnovejsi
technologif v jddrovém algoritmu pro rychlé
zpracovan( a odezvu, je pripraven rozsftit vasi
zkudenost s monitory Philips!

11

El Instalace

* Postupujte podle pokynt a dokoncete
instalaci.

*  MuZzete spustit po dokoncenf instalace.

*  Chcete-li spustit pozdéji, mlzete klepnout
na zastupce na pracovni plose nebo na
panel ndstroju.

PHILIPS

Monitor driver and software installation

Prvni spusténi —Wizard (Privodce)

*  Pri prvnim spusténi po instalaci prejde
SmartControl Lite automaticky na Wizard
(Pravodce).

* Tento prlvodce vds provede podrobnym
nastavenim vykonu monitoru.

*  Prlvodce mlzete rovnéz spustit pozdéji z
nabidky Plug-in (Zasuvny modul).

* Dalsf moZznosti mlzete nastavit bez
pravodce prostrednictvim podokna Standard
(Standardni).

rop A 7 x
ntrol Lite PHILIPS

Wizard

1 in gt



3. Optimalizace Obrazu

E1 Spusténi s podoknem Standard
(Standardni):

Nabidka Adjust (Nastaveni):

* Nabidka Adjust (Nastaveni) umozriuje
upravit Brightness (Jas), kontrast (Kontrast),
Focus (Ohnisko), Position (Poloha) a
Resolution (Rozlisent).

* Mdzete postupovat podle pokyn( a provést
nastavent.

*  Cancel (Storno) vyziva uzivatele, chcete-li
ukonit instalaci.

B st 3 P 22581 (CETLS000001) ] X

SmartControl Lite PHILIPS

* nghtnes =

saad

=

o s o=
[ Y- 3 P 72001 (cEris00tont) (X
SmartControl Lite PHILIPS

saad
%
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sead

B eurione

SmartControl Lite

is e

B earorne

SmartControl Lite

B eurione

SmartControl Lite

2- s 20 poetisonent) (X
PHILIPS

Focus.

2- i 21 (ostison0eny) (DX
PHILIPS

2- s 20 poetisonent) (X
PHILIPS
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3. Optimalizace Obrazu
Nabidka Color (Barva): | 2P coensint) 3%

Nabidka Color (Barva) umozriuje upravit SmartControl Lite PHILIPS
RGB, Black Level (Urovef ¢erné), White
Point (Bily bod), Color Calibration (Kalibrace
barev) a Smartlmage Lite (viz ¢ast \'
Smartimage Lite). '
MUlZete postupovat podle pokynt a provést

\5 RS
nastaveni. o

Display Gammiy

V ndsledujici tabulce vyhledejte polozku il ﬂ

podnabidky na zdkladé vaseho vstupu. \‘? Ot e

Priklad pro Color Calibration (Kalibrace "o >

barev) 2.
SmartControl Lite PHILIPS

[ y——— 3 i 32501 e seseons) (T

\' MR SmartControl Lite PHILIPS
' ]

-
oo ==
® -

[ - 3 Paies 72581 (00718000001 ) [0 \"‘E-
SmartControl Lite PHILIPS

1. Tlacitko ,,Show Me" (Predvést) spustf
vyukovy program pro kalibraci barev.

2. Start (Spustit) — zahdjf sekvenci kalibrace
barev o 6. krocich.

3. QuickView (Rychlé zobrazeni) nacte
zobrazeni pred/po.

e 4. Chcete-li se vrétit na hlavni stranku Color

..... (Barva), klepnéte na tlacitko Cancel

ap (Storno).

\‘ m 5. Enable color calibration (Povolit kalibraci
barev) — ve vychoz konfiguraci je zapnuto.
Pokud tato polozka nenf zaskrtnuta, kalibraci
barev nelze provést a tlacitka rychlé
zobrazeni nejsou k dispozici.

6. Na kalibra¢ni obrazovce musi byt zobrazeny
informace o patentech.
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3. Optimalizace Obrazu

Calibration Screen (Obrazovka kalibrace)
prvni barvy:

* Tlacitko Previous (Predchozi) je

deaktivovdno az na obrazovku druhé barvy.

*  Tlacitko Next (Dalsi) slouzi k prechodu na
nasledujici cil (6 cild).

*  Tlacitko Konecny slouzi k prechodu na File
> Presets (Soubor > podokno Predvolby).

* Tlacitko Cancel (Stormo) slouzi k ukoncenf
uzivatelského rozhranf a k ndvratu na
stranku zdsuvnych moduld plug-in.

Smartlmage Lite

Smartlmage — umozriuje uzivateli zménit
nastaven( pro vylepseni zobrazenf na zdkladé
obsahu.

Kdyz je nastavena moznost Entertainment
(Zabava), jsou polozky SmartContrast a
SmartResponse k dispozici.

[ X

SmartControl Lite PHILIPS

Smartimage

=2 .4
\g L

=]

is 13

Options>Preferences (Moznosti>Predvolby)
— Tato moznost bude aktivni pouze po
vybéru polozky Preferences (Predvolby) v

14

rozeviraci nabidce Options (MoZnosti). Na
nepodporovaném zobrazovacim zafizen( s
podporou DDC/Cl jsou k dispozici pouze karty
Help (Napovéda) a Options (MoZnosti).

[ Yo 2 - Pl 251 (CEI0TLS000001) (X

SmartControl Lite PHILIPS

Preferences

* Zobrazf nastaven( aktudinich predvoleb.

»  Zaskrtnuté tlacitko aktivuje funkci.
Zaskrtavaci policko je prepinac.

* PoloZka Enable Context Menu (Povolit
mistni nabidku) na pracovnf plose je ve
vychozi konfiguraci zaskrtnutd (Zapnuto).
Po aktivaci polozky Enable Context Menu
(Povolit mistni nabidku) se zobrazf vybéry
SmartControl Premium pro funkce Select
Preset (Vybrat predvolbu) a Tune Display
(Ladéni zobrazeni) na pracovni plose
klepnutim pravym tlacitkem mysi na mistnf
nabidku. Volbou moZznosti Deaktivovdno
bude polozka SmartControl Premium
odstranéna z mistni nabidky pravym
tlacitkem mysi.

* PoloZzka Enable Task Tray (Povolit ikonu na

hlavnim panelu) je ve vychozi konfiguraci
zaskrtnutd (Zapnuto). Po aktivaci polozky
Povolit mistni nabidku se zobraz( nabidka
SmartControl Lite na hlavnim panelu.
Klepnutim pravym tlacitkem mysi na ikonu
na hlavnim panelu se zobrazi moznosti
nabidky Help (Ndpovéda), Technical
Support (Odborna pomoc), Check for
Update (Vyhledat aktualizace), About

(O aplikaci) a Exit (Konec). Kdyz je
deaktivovdna polozka Enable task tray menu
(Povolit nabidku na hlavnim panelu), ikona
na hlavnim panelu zobrazuje pouze moznost
EXIT (KONEC).



*  PoloZka Run at Startup (Spustit pfi startu) je
ve vychozi konfiguraci zaskrtnutd (Zapnuto).
Kdyz je tato polozka deaktivovana, funkce
SmartControl Lite se nespusti pfi startu
nebo nebude na hlavnim panelu. Funkci
SmartControl Lite Ize spustit pouze
prostrednictvim zdstupce na pracovni
plose nebo prostrednictvim souboru
programu. Kdyz toto poli¢ko nenf zaskrtnuté
(Deaktivovdno), Zddna predvolba nastavena
pro spusténi pii startu nebude nactena.

* Enable transparency mode (Aktivovat rezim
prahlednosti) (Windows 7, Vista, XP).
Vychozi nastaveni je O % neprihlednost.

Options>Input (Moznosti>Vstup) — Tato
moznost bude aktivni pouze po vybéru
polozky Input (Vstup) v rozeviraci nabidce
Options (Moznosti). Na nepodporovaném
zobrazovacim zafizeni' s podporou DDC/CI
jsou k dispozici pouze karty Help (Ndpovéda)
a Options (Moznosti). Zddné dal3f karty funkce
SmartControl Lite nejsou k dispozici.

[ L Tx
PHILIPS

SmartControl Lite

» Zobrazi podokno s pokyny Source (Zdroj)
a nastaven( aktudlnto zdroje vstupu.

* U zobrazovacich zarizen( s jednim vstupem
nenf toto podokno zobrazeno.

Options>Audio (Moznosti>Zvuk) —Tato

moznost bude aktivni pouze po vybéru polozky

Audio (Hlasitost) v rozeviraci nabidce Options

(Moznosti).

Na nepodporovaném zobrazovacim zarizen( s

podporou DDC/Cl jsou k dispozici pouze karty

Help (Ndpovéda) a Options (Moznosti).
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Help>User Manual (Napovéda>Uzivatelska
prirucka) —Tato moznost bude aktivni pouze
po vybéru polozky User Manual (Uzivatelska
prirucka) v rozeviraci nabidce Help (Ndpovéda).
Na nepodporovaném zobrazovacim zarizeni s
podporou DDC/Cl jsou k dispozici pouze karty
Help (Ndpovéda) a Options (Moznosti).

s e
SmartControl Lite PHILIPS

=

- o
e e
e

Help>Version (Napovéda>Verze) — Tato
moznost bude aktivni pouze po vybéru

polozky Version (Verze) v rozeviraci nabidce
Help (Ndpovéda). Na nepodporovaném
zobrazovacim zarizeni s podporou DDC/CI
jsou k dispozici pouze karty Help (Ndpovéda) a
Options (Moznosti).



. e 7%

SmartControl Lite PHILIPS

Version

)
= R e |

LB

Context Sensitive menu (Mistni nabidka)
Context Sensitive Menu (Mistni nabidka) je
ve vychozi konfiguraci Aktivovana. Nabidka
bude zobrazena po zaskrtnuti polozky Enable
Context Menu (Povolit mistni nabidku) v ¢asti

Help

Technical Support
Check for Update
About

Exik

Hlavni panel obsahuje pét polozek:

Help (Napovéda) — pristup k souboru

s User Manual (uZzivatelskou priruckou):
Otevre soubor s User Manual (uzivatelskou
priruckou) v okné vychoziho prohlizece.
Technical Support (Odbornd pomoc) —
zobrazf stranku odborné pomoci.

Check for Update (Vyhledat aktualizace) —
zobraz( tvodni strdnku PDI a porovna verzi
uZivatele s nejaktudlnéjsi dostupnou verz.
About (O aplikaci) — zobrazi podrobné

referencni informace: verze produktu,
informace o vydani a ndzev produktu.
*  Exit (Konec) - ukonci SmartControl Lite

Options > podokno Preferences (Moznosti >
podokno Predvolby).

g SmartControl
Belect Presst 13
Tune Dizplay

Chcete-li znovu spustit funkci SmartControl Lite,
vyberte polozku SmartControl Lite z nabidky
Program, poklepejte na ikonu na pracovni plose
pocitae nebo restartujte pocital.

PHILIPS

Context Menu (Mistni nabidka) obsahuje Ctyri

polozky:

*  SmartControl Lite - po vybéru se zobrazf
obrazovka About (O) aplikaci.

*  Select Preset (Vybrat predvolbu) — nabizf
hierarchickou nabidku ulozenych predvoleb R
pro okamzité pouziti. Aktudlné vybrand ———m
predvolba je oznacena zaskrtnutim. V ey T
rozeviraci nabidce Ize rovnéz vybrat polozku
Predvolby vyrobce.

* Tune Display (Ladéni zobrazeni) — otevre
ovlddaci panel SmartControl Lite.

*  Smartlmage Lite — zkontrolujte aktualnf
nastaven( Standard (Standardn), Intemet,
Game (Hra).

SmartControl

Deaktivovana nabidka hlavniho panelu

Kdyz je hlavni panel deaktivovén ve slozce
Preference (Predvolby), je k dispozici pouze
cast EXIT (KONEC). Cheete-li funkci
SmartControl Lite zcela odstranit z hlavniho
panelu, deaktivujte polozku Run at Startup
(Spustit pri startu) v casti Options>Preferences
(Moznosti>Predvolby).

Aktivovana nabidka hlavniho panelu

Nabidku hlavniho panelu Ize zobrazit klepnutim
pravym tlacitkem mysi na ikonu SmartControl
Lite na hlavnim panelu. Klepnutim levym
tlacitkem lze spustit aplikaci.
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4. PowerSensor™

(K dispozici pouze pro model 227E3LPH)

PowerSensor je jedinecna ekologickd technologie od spolecnosti Philips, kterd umozniuje usetrit az 80 %
spotreby energie. Spolecné s citem a jednoduchostf Philips tato uzivatelsky prijemna technologie funguje
ihned po vybalenf bez nutnosti instalace hardwaru nebo softwaru a bez jakéhokoli zdsahu uzivatele ve
vychozim rezimu.

(1] Jak to funguje?

* PowerSensor funguje na principu vysilani a prijimani neskodnych , infracervenych signdl za icelem
rozpozndvani pritomnosti uzivatele.

*  Kdyz se uZivatel nachdzi pred monitorem, monitor funguje normalné podle nastavent, kterd uZivatel
predem proved! — tzn. jas, kontrast, barva atd.

*  Napiiklad jestlize byl monitor nastaven na 100% jas, v okamziku, kdy uZivatel opusti své misto a
nenachazi se pred monitorem, monitor automaticky omez( spotriebu az o 80 %.

Uzivatel pred monitorem Zadny uzivatel pfed monitorem

Prikon uvedeny vy3e je pouze informativni

Bl Nastaveni

Vychozi nastaveni

Ve vychozim nastaveni (Nastaveni 3) technologie PowerSensor rozpozndva prtomnost uZivatele
monitoru, ktery se nachazi mezi 90 a 110 cm (35,4 a 43,3 palci) od monitoru a v Uhlu pét stupnid
nalevo a napravo od monitoru.

Vlastni nastaveni
*  Kdyz uzivatel zvoli polohu mimo vyse uvedené perimetry, zvolte vy33i silu signdlu pro optimalnf

Ucinnost rozpozndvanf: S vyssim nastavenim se zesiluje signdl rozpozndvani. Pro dosazeni maximaln{
Ucinnosti technologie PowerSensor a spravné detekce sedte primo pried monitorem.

* Pokud se rozhodnete posadit ddle nez 110 cm nebo 43,3 palci od monitoru, pouzifte maximalnf
signdl rozpozndvéni pro vzddlenosti do 130 cm nebo 51,2 palcl. (Nastaveni 4)

*  Vzhledem k tomu, Ze md barevné oblecen( tendenci absorbovat infracervené signdly i kdyz se
uZivatel nachdzi do vzddlenosti 100 cm nebo 40 palct od monitoru, zvyste silu signalu, pokud mate
na sobé cerné nebo tmavé oblecen.

*  Kdykoli se miZete vrétit do vychoziho rezimu (Nastaveni 3).
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4. PowerSensor

Rychlé tlacitko Vzdélenost snimace

s ‘-IIIIIIIIIIIIIIIIIII +3

v LI SENSOR/ 4 /oK [0)

_—

H Pokyny pro zmény nastaveni

Pokud technologie PowerSensor nefunguje spravné uvniti nebo vné vychoziho rozsahu, jemné
vyladte rozpozndvdni podle ndsledujicich pokynu:

»  Stisknéte kldvesovou zkratku PowerSensor:

*  Najdete vychozi polohu ‘3" na panelu nastaveni.

» Upravte nastaveni rozpoznavani technologie PowerSensor na Nastaveni 4 a stisknéte OK.

*  Vyzkousejte novou konfiguraci a presvédcte se, zda vas technologie PowerSensor rddné
rozpozndvd ve vasf aktudini poloze.

& Poznamka

Rucné vybrany rezim PowerSensor zUstane funkéni, dokud jej nezménite nebo dokud neobnovite
vychozi rezim. Pokud je technologie PowerSensor pfilis citlivd na okolnf pohyb, vyzkousejte mensi silu
signalu.
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5. Technické udaje

Typ panelu LCD TFT-LCD
Podsvicenf LED

Velikost panelu 21,5" (54,6 cm)
Pomér stran 16:9

Rozte¢ obrazovych bodu 0,248 x 0,248 mm
Jas 250 cd/m?
SmartContrast 20.000.000:1
Kontrastni pomér (typ.) 1000:1

Doba odezvy (typicka) 5ms

Optimalnf rozlisenf

1920 x 1080 pri 60 Hz

Vstup signalu

Zorny Uhel 170° (H) / 160° (V) pri C/R>10
VylepSenf obrazu Smartlmage Lite

Barevnost displeje 16,7 M

Vertikalni obnovovaci frekvence | 56 Hz - 76 Hz

Horizontdlnf frekvence 30 kHz - 83 kHz

sRGB ANO

DVI-D (digitélni), VGA (analogovy)
HDMI (k dispozici pro model 227E3LH, 227E3LPH)

Vstupnf signdl

Usnadnénf pro uzivatele

Oddélena synchronizace, synchronizace podle zelené

227E3L: /v ©/A /< /0K 0}
227E3LH:  Ep/v ©/A 10/4 /0K 0
227E3LPH: ED/v ©/A SENSOR/ < /0K 0

Jazyky nabidky OSD

anglictina, francouzstina, némcina, italstina, rustina, Spanélstina,
zjednodusena ¢instina, portugalstina, turectina

Dalsi usnadnénf

Zamek Kensington

Kompatibilita s technologif
Plug & Play

Naklon

DDC/CI, sRGB, Windows 7/Vista/XP, Mac OSX, Linux

-5/4+20
27E3L: 218 W (typ)
27E3LH: 21,8 W (typ.), 27 W (max))

Zapnuto

227E3LPH: 21,8 W (typ.), 24 W (max.)

Spotreba energie (Metoda
testovani EnergyStar 5.0)

Stridavé vstupnf Strifdavé vstupni
napétl pri 100 VAC | napéti pri 115 VAC
+/-5 VAC, 50 Hz +/-5 VAC, 60 Hz
+/-3 Hz +/-3 Hz

Stridavé vstupni
napétf pri 230 VAC
+/-5 VAC, 50 Hz
+/-3 Hz

Normalni provoz (typ.)

184 W 184 W 185 W
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Rozptyl tepla*

Spanek 05 W 05 W 05W
Vypnuto 05W 05 W 05W
Stridavé vstupnf Stridavé vstupni Stridavé vstupni

napéti pri 100 VAC
+/-5 VAC, 50 Hz
+/-3 Hz

napéti pri 115 VAC
+/-5 VAC, 60 Hz
+/-3 Hz

napéti pri 230 VAC
+/-5 VAC, 50 Hz
+/-3 Hz

BéZny provoz

62,8 BTU/hod. 62,8 BTU/hod. 63,14 BTU/hod.

Spének 1,71 BTU/hod. 1,71 BTU/hod. 1,71 BTU/hod.
Vypnuto 1,71 BTU/hod. 1,71 BTU/hod. 1,71 BTU/hod.
Indikdtor napdjenf Zapnuto: Bild, Pohotovostni rezim/rezim spanku: Bild (blikd)
Napdjeni Vypdleni, 100-240VAC, 50-60Hz

Vyrobek s podstavce (SxVxH)

534,34 x 407,9 x 216 mm

Vyrobek bez podstavce (SxVxH)

534,34 x 335,89 x 41,1 mm

Teplotni rozsah (provoz)

Vyrobek s podstavcem 4,01 kg
Vyrobek bez podstavce 3,47 kg
Vyrobek s obalem 417 kg

0°C az 40 °C

Teplotni rozsah (mimo provoz)

-20°C az 60°C

Relativni vihkost

20% az 80%

Pouzirdnf: + 12 000 stop (3 658 m)

Prohlaseni o shodé

Barva

Nadmorsid vyska Mimo provoz: + 40 000 stop (12 192 m)
MTBF 30 000 hod.

ROHS ANO

EPEAT Silver (www.epeat.net)

Balenf 100% recyklovatelny

CE Mark, FCC Class B, GOST, SEMKO, TCO Certified, UL/cUL,
BSMI, 1SO9241-307

Cerné (zadnf &st), modré (prednf &ast)

Povrchova dprava

Leskld

© Poznamka

1. Certifikdt EPEAT Gold nebo Silver je platny pouze tam, kde spolec¢nost Philips zaregistruje produkt.
Informace o stavu registrace ve vasi zemi viz www.epeat.net.
2. Tyto Udaje se mohou zménit bez predchoziho ozndment. Stéhnéte si nejnovéjsi verzi letdku z webu

www.philips.com/support.
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.Technické tdaje

5.1 Rezimy rozliseni a predvoleb

H Maximalni rozliseni
1920 x 1080 pri 60 Hz (analogovy vstup)
1920 x 1080 pri 60 Hz (digitalni vstup)

Bl Doporuéené rozliseni
1920 x 1080 pri 60 Hz (digitdni vstup)

[Formee [ Rozigeni [Ty [V frek () |
480i 720 x480 | SD |60

480p 720 x480 | SD |60

576i 720x 576 | SD (50

576p 720 x 576 | SD |50

720p | 1280 x 720 | HD |50, 60

1080i | 1920 x 1080 | HD (50, 60

1080p | 1920 x 1080 | HD (24, 25, 30, 50, 60

& Poznimka

Upozomiujeme Vvds, ze tento monitor funguje
nejlépe pri nativnim rozliseni 1920 X 1080 pr
60 Hz. Pro dosazen( optimalni kvality zobrazenf
dodrzujte toto doporucené rozlisen.
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6. Rizeni spotreby

Pokud je v daném pocitaci nainstalovan software
nebo videokarta vyhovujici normé DPM
organizace VESA, monitor dokdze automaticky
snizit svou spotrebu energie, neni-li pouzivan.
Pokud pocfta¢ rozpoznad vstup z kldvesnice,

my3i nebo jiného vstupniho zaffzenf, monitor se
automaticky ,,probudi*. Nasledujici tabulka uvadf
spotrebu energie a signalizaci této funkce pro

automatickou Usporu energie:

ReZim VESA | Video |H-synch. |V-synch.| Spotieba energie |Barva indikdtoru LED
Akdivni ZAP. | Ano Ano | <218W (typ) Bild
Spanek VYP. Ne Ne <05 W (typ.) Bild (blikd)
Vypnuto | VYP. - - <05 W (typ) VYP.

Nasledujici konfigurace se pouzivd pri mérenf
energetické spotreby tohoto monitoru.

Nativni rozlisenf: 1920 x 1080

Kontrast: 50%

Jas: 250 nitd

Barevnd teplota: 6500 K's pIné bilym vzorkem

& Poznimka
Tyto Udaje se mohou zménit bez predchoziho
oznament.
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7. Informace o regulaci

Lead-free Product

Lead free display promotes
environmentally sound recovery
and disposal of waste from electrical
and electronic equipment. Toxic
substances like Lead has been eliminated

and compliance with European community’s
stringent RoHs directive mandating restrictions
on hazardous substances in electrical and
electronic equipment have been adhered to

in order to make Philips monitors safe to use
throughout its life cycle.

Congratulations!

This display is designed for both you and the
planet

The display you have just purchased
carries the TCO Certified label.

This ensures that your display is
designed, manufactured and tested according to
some of the strictest quality and environmental
requirements in the world. This makes for a
high performance product, designed with the
user in focus that also minimizes the impact on
the climate and our natural environment.

TCO Certified is a third party verified program,
where every product model is tested by an
accredited impartial test laboratory. TCO
Certified represents one of the toughest
certifications for displays worldwide.

Some of the Usability features of the TCO
Certified for displays:

* Visual ergonomics for good image quality
is tested to ensure top performance and
reduce sight and strain problems. Important
parameters are luminance, contrast,
resolution, black level, gamma curve, colour
and luminance uniformity and colour
rendering.

*  Products are tested according to rigorous
safety standards at impartial laboratories.

* Electric and magnetic fields emissions as
low as normal household background
levels.

* Low acoustic noise emissions (when
applicable).

Some of the Environmental features of the
TCO Certified for displays:

* The brand owner demonstrates corporate
social responsibility and has a certified
environmental management system (EMAS
or 1SO 14001).

*  Very low energy consumption both in on-
and standby mode minimize climate impact.

* Restrictions on chlorinated and brominated
flame retardants, plasticizers, plastics and
heavy metals such as cadmium, mercury
and lead (RoHS compliance).

* Both product and product packaging is
prepared for recycling.

* The brand owner offers take-back options.

The requirements can be downloaded from our
web site. The requirements included in this label
have been developed by TCO Development

in co-operation with scientists, experts, users as
well as manufacturers all over the world. Since
the end of the 1980s TCO has been involved

in influencing the development of IT equipment
in a more user-friendly direction. Our labeling
system started with displays in 1992 and is

now requested by users and [T-manufacturers
all over the world. About 50% of all displays
worldwide are TCO certified.

For more information, please visit:
www.tcodevelopment.com

TCOF1058 TCO Document, Ver. 2.1

I[n Technology for you and the planet
CERTIFIED



EPEAT
(www.epeat.net)

“The EPEAT (Electronic Product
@ Environmental Assessment Tool)

program evaluates computer

desktops, laptops, and monitors
based on 571 environmental criteria developed
through an extensive stakeholder consensus
process supported by US EPA.

EPEAT system helps purchasers in the public
and private sectors evaluate, compare and
select desktop computers, notebooks and
monitors based on their environmental
attributes. EPEAT also provides a clear and
consistent set of performance criteria for the
design of products, and provides an opportunity
for manufacturers to secure market recognition
for efforts to reduce the environmental impact
of its products.”

Benefits of EPEAT

Reduce use of primary materials
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT'S
requirement that all registered products meet
ENERGY STAR'’s energy efficiency specifications,
means that these products will consume less
energy throughout their life.
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CE Declaration of Conformity

This product is in conformity with the following
standards

* EN60950-1:2006 (Safety requirement of
Information Technology Equipment).

»  EN55022:2006 (Radio Disturbance
requirement of Information Technology
Equipment).

*  EN55024:1998+A1:2001+A2:2003
(Immunity requirement of Information
Technology Equipment).

*  EN61000-3-2:2006 (Limits for Harmonic
Current Emission).

e EN61000-3-3:1995+A1:2001+A2:2005
(Limitation of Voltage Fluctuation and
Flicker) following provisions of directives
applicable.

* 2006/95/EC (Low Voltage Directive).

»  2004/108/EC (EMC Directive).

» 2005/32/EC (EuP Directive, EC No.
1275/2008 mplementing Directive
for Standby and Off mode power
consumption) and is produced by a
manufacturing organization on 1SO9000
level.

The product also comply with the following

standards

* 15S09241-307:2008 (Ergonomic
requirement, Analysis and compliance test
methods for electronic visual displays).

*  GS EK1-2000:2009 (GS mark requirement).

»  prEN50279:1998 (Low Frequency Electric
and Magnetic fields for Visual Display).

*  MPR-Il (MPR:1990:8/1990:10 Low
Frequency Electric and Magnetic fields).

*  TCO CERTIFIED (Requirement for
Environment Labeling of Ergonomics,
Energy, Ecology and Emission, TCO: Swedish
Confederation of Professional Employees)
for TCO versions.



Energy Star Declaration

(www.energystar.gov)

As an ENERGY STAR® Partner, we
have determined that this product

meets the ENERGY STAR®
guidelines for energy efficiency.

i)

& Note

We recommend you switch off the monitor
when it is not in use for a long time.

Federal Communications Commission (FCC)
Notice (U.S. Only)

€ This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation.
This equipment generates, uses and can
radiate radio frequency energy and, if not
installed and used in accordance with the
instructions, may cause harmful interference
to radio communications.

However, there is no guarantee that
interference will not occur in a particular
installation. If this equipment does cause
harmful interference to radio or television
reception, which can be determined by
turning the equipment off and on, the
user is encouraged to try to correct

the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

»  Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

»  Consult the dealer or an experienced
radio/TV technician for help.
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@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority
to operate the equipment.

Use only RF shielded cable that was supplied
with the monitor when connecting this monitor
to a computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

FC

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following
two conditions: (1) this device may not cause
harmful interference, and (2) this device must
accept any interference received, including
interference that may cause undesired
operation.

Commission Federale de la Communication
(FCC Declaration)

© Cet équipement a été testé et déclaré
conforme auxlimites des appareils
numériques de class B,aux termes de l'article
15 Des regles de la FCC. Ces limites sont
congues de facon a fourir une protection
raisonnable contre les interférences nuisibles
dans le cadre d'une installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est
pas installé et utilisé selon les consignes
données, peuvent causer des interférences
nuisibles aux communications radio.



. Informace o regulaci

Cependant, rien ne peut garantir I'absence
d'interférences dans le cadre d'une
installation particuliere. Si cet appareil est
la cause d'interférences nuisibles pour

la réception des signaux de radio ou de
télévision, ce qui peut étre décelé en
fermant I'équipement, puis en le remettant
en fonction, I'utilisateur pourrait essayer de
corriger la situation en prenant les mesures
suivantes:

* Réorienter ou déplacer I'antenne de
réception.

* Augmenter la distance entre I'équipement
et le récepteur.

* Brancher '¢quipement sur un autre circuit
que celui utilisé par le récepteur.

e Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

@ Toutes modifications n'ayant pas recu
I'approbation des services compétents
en matiere de conformité est susceptible
d'interdire a I'utilisateur I'usage du présent
équipement.

N'utiliser que des cables RF armés pour
les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTE TOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.

EN 55022 Compliance (Czech Republic Only)

This dswice belongs to category B devices as described in EN 55022, unless it is specifi-
cally stated that it i a Class A devics on the epeciication labal. The following apglies to
devices in Class A of EN 55022 (radius of protection up to 30 metars). The user of the
davics is obliged to take all stapa necessary o remove sources of interfsrence io tela-
communication or other devicas.

Pokud neni na typovém Stitku po&itade uvedeno, 28 spadé dodo tfidy A podie EN 55022,
spadd automaticky do thidy B podie EN 55022, Pro zafizeni zafazend do tidy A (chranné
pésma 30m) podie EN B5022 plati nésledujicl. Dojde-li k ruien! telekomunikadnich nebo
Jinjch zafizeni je utivatal povinnen provést takovd opatfgnl, by neeni odstranil,

Polish Center for Testing and Certification
Notice

The equipment should draw power from a
socket with an attached protection circuit (a
three-prong socket). All equipment that works
together (computer, monitor, printer, and so
on) should have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection
usage requirements of standards PN-93/
T-42107 and PN-89/E-06251.

Wymagania Polskiego Centrum Badan i Certyfikacji
Uneagdzenie powinno byé ssitane # priazds 2 preylaceanym obwodem ochronnym (gnizedo ¢
katkiem). Wﬂpé\'s'dnujact iz sohy urzadzenia (komputer, monitor, drukarka) powinmy byé zsilane
2 1ep0 samego

nstalsca clekirycans pomiexaczenia o sawiemt w prswozle 0wy epwana achrone
proeel warciami, w pestaci bezpieczntka o wartote mamicnawe nie wigkszej niz 16A (amperio).
W el calkewitege wylpeeenia urqdzenia 2 sieer zasilanta, naledy wyjad wiyceke kabla
easilaigeepo 2 priaedka, kidre powinno enjdowad sig w poblia udemna 1 b Batwo dostepne.
Taak bespiecsefsrwa "B potwiendss podnosé uresdseia 2 wynaganiami beapiecaehstva
weytkowania awartymi w PN-SRT4207 § PR-89E06251.

Pozostale instrukcje begpieczensiwa

* i nalety ukywad wryczek adaptercwych Tub usuwaé kolka abwodu ochronnego 2 wiycaki,
Jepeli kosoczne jost iy peacdluzaczs  nalezy uzyt preodiuiacea -iylowega 2

Sy-cln.'m ¥ maleiy ieceyd preed nagtymi, i wrrostami bub spad-
Vs mapigei, wdywajas elimnalors prospiss, urradsenia depasaajicege b

berzakiicenivweia frodia zasilania.

* Nalezy upewitié sig. sby n e lezalo na ksblach systemu kompulerowess. araz aby kable nie
byky umieszczone w mlegscu, gdzie modna byloby na nic nadeptywad lub porykad sie o ie.

* i maleiy rorlwad nspaiow i nayeh plyaiw s systens koaputesony.

Nie malezy wpychat sacnych p i systemm o, guvi moke

to spowodwai poiar Iuhpmlm\e;r.(dmu poprzes rwarcie elementim wewngtrenych

* System komputerowy powisien znajdowad sig 2 dala od grzejaikiw : fidel elepla. Porsdro,

e ey blakawad atwordw wenylacynych. Nalezy unikac kludensa luinyeh papierdw pod

karmputera w i cyrhalacii powi-
etz wokil niego.



North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR
DU STALLER DIN UTRUSTNING PAPLATS,

Placering/Ventilation

ADVARSEL:

SORG VED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT
ER NEMT TILGANGELIGE.

Paikka/llmankierto

VAROITUS:

SIJOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR

ST@MTILF@RSEL ER LETTE A NA.

BSMI Notice (Taiwan Only)
RAZEARERIIBE |

Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht
den in der "Verordnung Uber den Schutz vor
Schiden durch Rontgenstrahlen" festgelegten
Vorschriften.

Auf der Rickwand des Geréates befindet sich
ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften
Uber die Bauart von Stérstrahlern nach Anlage
a5 Abs. 4 der Réntgenverordnung erfiilit
sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, dal3

1. Reparaturen nur durch Fachpersonal
durchgefihrt werden.
2. nur original-Ersatzteile verwendet werden.

bei Ersatz der Bildréhre nur eine
bauartgleiche eingebaut wird.

Aus ergonomischen Grinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf
dunklem Untergrund zu verwenden (schlechte
Lesbarkeit und erhdhte Augenbelastung bei zu
geringem Zeichenkontrast waren die Folge).
Der arbeitsplatzbezogene Schalldruckpegel
nach DIN 45 635 betrdgt 70dB (A) oder
weniger.

) ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLUB LEICHT
ZUGANGLICH SIND.



. Informace o regulaci

China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products including CRT and Monitor
which are produced and sold for China market
have to meet China RoHS request.
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8. Péce o zakazniky a zaruka

8.1 Postup pri vadnych pixelech
plochého panelu spolecnosti
Philips

Spolecnost Philips se snazi doddvat vyrobky
vyrobnich postupl vyroby v tomto odvétvi a
prosazuje prisnou kontrolu kvality. Defektiim
obrazovych bodl nebo dil¢ich obrazovych
bodd u paneld TFT LCD, které se pouzivaj
pro ploché monitory, se nicméné nékdy neda
zabranit. Zadny vyrobce nemuize zarudit, ze
viechny panely budou bez defektd obrazovych
bod, ale spolec¢nost Philips zarucuje, ze kazdy
monitor s nepfijatelnym poctem defektd bude
v rdmci zdruky opraven nebo vymeénén. Tento
text vysvétluje jednotlivé druhy defektd na
pixelech a urcuje Unosnou Uroveri chybovosti
pro kazdy druh. Aby bylo mozné uplatnit zaru¢ni
opravu nebo vyménu, musi pocet defektnich
obrazovych bodl panelu TFT LCD presdhnout
tuto Uroveri dnosnosti. Na monitoru napriklad
nesmi byt vice defektnich dil¢ich obrazovych
bodl nez 0,0004 %. Ddle, protoZze nékteré typy
kombinaci vad pixell jsou Iépe postrehnutelné
nez jiné, stanovuje pro né spolec¢nost Philips
jesté vetsi ndroky na kvalitu. Tato norma se
dodrzuje celosvétove.

subpixely subpixely subpixely

vy
pixely

Pixely a subpixely

Pixel, neboli obrazovkovy bod, se sklddd ze
subpixeld v zdkladnich barvéch cervené, zelené a
modré. KdyzZ je mnoho pixeld pohromadg, tvorf
obraz. Kdyz viechny subpixely uréitého pixelu
svitf, jevi se tyto tii subpixely spole¢né jako
jediny bfly pixel. KdyZ jsou viechny tmavé, jevi
se tyto ti subpixely jako jeden cerny pixel. Dals{
kombinace rozsvicenych a tmavych subpixell se
jevi jako pixely rliznych barev.

Druhy pixelovych vad

Vady pixell a subpixeld se na obrazovce
projevuji riznymi zpUsoby. Existuji dva druhy vad
pixelu a v rdmci téchto druhd je nékolik typd
subpixelovych vad.

Defekty svétlych bodl

Defekty svétlych bodl se projevuji jako
obrazové body nebo dil¢i obrazové body, které
vzdy sviti nebo jsou 'aktivni'. Svétly bod je dilel
obrazovy bod, ktery vystupuje z obrazovky, kdyz
je na monitoru zobrazena tmavd plocha. Existujf
nasledujici typy defektl svétlych bodu:

Jeden cerveny, zeleny nebo modry subpixel

I C

Dva soundleZici subpixely:

- cerveny + modry = fialovy

- Cerveny + zeleny = Zluty

- zeleny + modry = svétle modry

Tri soundlezicl rozsvicené subpixely (jeden bily
pixel)




€ Poznamka

Cerveny nebo modry svétly bod musf byt o
vice nez 50 procent jasnéjsi, nez sousedni body;
zeleny svétly bod je o 30 procent jasnéjsi, nez
sousedn( body.

Defekty tmavych bodl

Defekty tmavych bodu se projevujf jako
obrazové body nebo dil¢f obrazové body, které
nikdy nesvitf nebo jsou ,,neaktivni. Tmavy bod je
dil¢i obrazovy bod, ktery vystupuje z obrazovky,
kdyZ je na monitoru zobrazena sv&tld plocha.
Existuji nasledujici typy defektd tmavych bodu:

Vzdalenost pixelovych vad

ProtoZe vady pixell a subpixell stejného

typu, které se vyskytuji blizko sebe, mohou byt
patrnéjsi, urcuje spolec¢nost Philips i tolerance na
vzdélenost vad pixeld.

Tolerance vad pixelt

Aby bylo mozné uplatnit opravu nebo vyménu
kvlli defektnim obrazovym bodlm v zdru¢nf
dobé, musi panel TFT LCD plochého monitoru
Philips vykazovat defekty obrazovych bodl
nebo dil¢ich obrazovych bodu, které prekracujf
tolerance uvedené v nasledujicich tabulkéch.

KAZY JASNYCH BODU

PRIJATELNY POCET VAD

1 trvale sviticl bod 3
2 sousedni trvale svitici body 1
3 sousedn( trvale svitici body (nebo 1 trvale svitici bily bod) 0
Vzddlenost mezi dvéma kazy jasnych bodi* >15 mm
Celkovy pocet kazl jasnych bodd viech typl 3

KAZY CERNYCH BODU
1 tmavy bod

PRIJATELNY POCET VAD
5 nebo méné

2 sousedni tmavé body

2 nebo méné

3 sousedni tmavé body

0

Vzddlenost mezi dvéma kazy cemych bodi*

>15 mm

Celkovy pocet kazt ¢ernych bodd viech typl

5 nebo méné

KAZy bodl celkem

Celkovy pocet kazl jasnych nebo ¢ernych bodut viech typl

PRIJATELNY POCET VAD
5 nebo méné

& Poznamka

1. 1 nebo 2 sousedni vadné body (1 barva) = 1 vadny bod
2. Tento monitor je kompatibilni se standardem ISO 9241-307. ( ISO 9241-307: Ergonimicky
pozadavek, analyza a metody testovdni shody pro elektronicka zobrazovacf zarizen)




8.2 Péce o zakazniky & zaruka

Podrobné informace o zaruce a pozadavku na dodateénou podporu platné pro vasi oblast najdete na
webu www.philips.com/support. Rovnéz mizete kontaktovat mistni centrum péce o zdkazniky na nize

uvedenych telefonnich &islech.

Kontaktni informace pro oblast ZAPADNI EVROPY:

A

Germany Siemens &S +49 01803 386 853 €009
United Kingdom Invec Scotland +44 0207 949 0069 Local call tariff
Ireland Invec Scotland +353 01 601 1161 Local call tariff
Spain Eatsa Spain +34 902 888 785 €010
Finland A-novo +358 09 2290 1908 Local call tariff
France A-novo +33 082161 1658 € 0,09
Greece Allman Hellas +30 00800 3122 1223 Free of charge
Italy A-novo +39 840 320 041 €0,08
Netherlands E Care +31 0900 0400 063 €010
Denmark A-novo +45 3525 8761 Local call tariff
Norway A-novo +47 2270 8250 Local call tariff
Sweden A-novo +46 08 632 0016 Local call tariff
Poland Zolter +48 0223491505 Local call tariff
Austria Siemens &S +43 0810 000206 €007
Belgium E Care +32 078 250851 € 0,06
Luxembourg E Care +352 26 84 30 00 Local call tariff
Portugal Eatsa Spain +351 2 1359 1440 Local call tariff
Switzerland A-novo +41 02 2310 2116 Local call tariff
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Kontaktni informace pro oblast STREDNI A VYCHODNI EVROPY:

ame elefo ed o A o zaka é pece

BELARUS NA IBA +375 17 217 3386
BULGARIA NA LAN Service +359 2 960 2360
CROATIA NA Renoprom +385 1 333 0974
ESTONIA NA FUJITSU +372 6519900
LATVIA NA “ServiceNet LV" Ltd. +371 7460399
LITHUANIA NA UAB "Servicenet" +370 7400088
ROMANIA NA Blue Ridge Intl. +40 21 2101969
S eere [NA Kim Tec doo. +381 11 20 70 684
SLOVENIA NA PC H.and +386 1 530 08 24
NA Comel +380 562320045
HIRAINE NA g‘:ﬂa;;‘jvice +38 044 245 73 31
R NA CPS +7 (495) 645 6746 (for repair)
NA CEEE Partners +7 (495) 645 3010 (for sales)
Slovakia NA Datalan Service +421 2 49207155
Turkey NA Techpro +90 212 444 4 832
Czech Rep. NA Asupport 800 100 697
Hungary NA Serware , +36 1 2426331
NA Profi Service +36 1 814 8080

Kontaktni informace pro oblast LATINSKE AMERIKY:

Telefonni stredisko Cislo zakaznické péce
Brazil 0800-7254101
Vermont
Argentina 0800 3330 856

Kontaktni informace pro Cinu:

Cina

Cislo zdkaznické péce: 4008 800 008

Kontaktni informace pro SEVERNI AMERIKU:

USA. TOS Teleplan (877) 835-1838
Canada Supercom Supercom (800) 479-6696
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Kontaktni informace pro oblast APMEA:

Australia NA AGOS NETWORK PTY LTD [ 1300 360 386
New Zealand NA Visual Group Ltd. 0800 657447
. Hong Kong:Tel: +852 2619 9639
Hong Kong / Macau | NA Smart Pixels Technology Ltd. MacauTel: (853)-0800-987
. Tel: 1 800 425 6396
India NA REDINGTON INDIA LTD SMS: PHILIPS 1o 56477
Ind . NA PT. Gadingsari elektronika Tel: 62 21 75909053, 75909056,
AEonesia Prima 7511530
South Korea NA PCS One Korea Ltd. 080-600-6600
. After Market Solutions (CE)
Malaysia NA Sdn Bhd 603 7953 3370
Pakistan NA Philips Consumer Service (9221) 273741116
Philips Electronics Singapore
Singapore NA Pte Ltd (Philips Consumer (65) 6882 3999
Care Center)
PCCW
Taiwan Teleservices FETEC.CO 0800-231-099
Taiwan
Thailand NA f;‘s Computer System Co. | (471 934.5498
South Africa NA Sylvara Technologies Pty Ltd | 086 0000 888
UNITED ARAB AL SHAHD COMPUTER
EMIRATES NA LLC 00971 4 2276525
Israel NA Eastronics LTD 1-800-567000
, : +84 8 38248007 Ho Chi Minh City
Vietnam NA FCZTmsear:'citg‘format'c +84 5113.562666 Danang City
Py +84 5113.562666 Can tho Province
I . (02) 633-4533 to 34,
Philippines NA Glee Electronics, Inc. (02) 637-6559 to 60
Sri Lanka NA no d!strlbutor and/or service
provider currently
Bangladesh NA Distributor: Computer Source | 880-2-9141747, 9127592
g Ltd (warranty buy-out) 880-2-8128848 / 52
Nepal NA Distributor: Syakar Co. Ltd 97714222395
(warranty buy-out)
Distributor: Neat Technology
Cambodia NA Pte Ltd (Singapore) (warranty | 855-023-999992

buy-out)
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9. Odstranovani problém0 a
Casté dotazy

9.1 Odstranovani problému

Na této strdnce jsou uvedeny problémy,
které mlZe odstranit uZivatel. Pokud problém
pretrvdvd i po vyzkousenf téchto resent,
kontaktujte zastupce sluzeb pro zdkazniky
spolecnosti Philips.

El Bé&iné problémy

Zadny obraz (indikator LED napajeni nesvit)

»  Zkontrolujte, zda je napdjeci kabel pripojen
k elektrické zdsuvce a do zadni ¢asti
monitoru.

*  Nejdrive zkontrolujte, zda se vypinac na
predni strané monitoru nachazi ve OFF
(VYPNUTE) poloze a stiskn&te jej do ON
(ZAPNUTE) polohy.

Zidny obraz (indikitor LED napajeni je bily)

»  Zkontrolujte, zda je zapnuty pocitac.

*  Zkontrolujte, zda je kabel signdlu rddné
pripojen k pocitadi.

» Zkontrolujte, zda nejsou ohnuté koliky na
pripojovac( strané kabelu monitoru. Pokud
ano, opravte nebo vymérite kabel.

*  Pravdépodobné je aktivovdna funkce rizenf
spotreby

Obrazovka rika

Attention

Check cable connection

»  Zkontrolujte, zda je kabel monitoru rddné
pripojen k pocitaci. (Rovnéz viz Strucnd
prirucka).

»  Zkontrolujte, zda nejsou ohnuté koliky
kabelu monitoru.

»  Zkontrolujte, zda je zapnuty pocital.
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Tlacitko AUTO nefunguje

* Automaticka funkce je pouzitelnd pouze
v rezimu VGA-analogovy. Pokud vysledek
neni uspokojivy, mizete provést ru¢nf
Upravy prostrednictvim nabidky OSD.

€& Poznimka
Automatickd funkce nenf pouzitelnd v
rezimu DVI-digitdInf, protoZe je zbytecnd.

Viditelné znamky koure nebo jiskreni

*  Neprovddéjte zddné kroky pro odstrariovan{
problémd

*  Pro zajistén( bezpecnosti ihned odpojte
monitor od zdroje napdjenf

* |hned kontaktujte zastupce sluzeb pro
zékazniky spolecnosti Philips.

El Problémy se zobrazenim

Obraz neni vystredén

»  Upravte polohu obrazu pomocf funkce
,Auto” v hlavnich ovlddacich prvcich OSD.

*  Upravte polohu obrazu pomoci polozek
Phase/Clock (Faze/frekvence) v &asti Setup
(Nastaveni) v OSD Main Controls (Hlavnf
ovladaci prvky OSD). Tato funkce je platnd
pouze v rezimu VGA.

Obraz se chvéje na obrazovce

»  Zkontrolujte, zda je kabel signdlu rddné a
bezpelné pripojen ke grafické desce nebo k
pocitaci.

Dochazi ke svislému blikani

*  Upravte polohu obrazu pomocf funkce
,Auto” v hlavnich ovldadacich prvecich OSD.

*  Omezte svislé pruhy pomoci polozek
Phase/Clock (Faze/frekvence) v &asti Setup
(Nastaveni) v OSD Main Controls (Hlavnf
ovlddac( prvky OSD). Tato funkce je platnd
pouze v rezimu VGA.



Dochazi k vodorovnému blikani

*  Upravte polohu obrazu pomoci funkce
,Auto' v hlavnich ovlddacich prvcich OSD.

*  Omezte svislé pruhy pomoci polozek
Phase/Clock (Faze/frekvence) v ¢asti Setup
(Nastaveni) v OSD Main Controls (Hlavnf
ovlddac( prvky OSD). Tato funkce je platnd
pouze v rezimu VGA.

Obraz je rozmazany, nevyrazny nebo prilis
tmavy
*  Upravte kontrast a jas na obrazovce OSD.

,Dosvit", ,,vypileni* nebo ,,zobrazeni duchi*

zlstane po vypnuti napajeni.

* Dlouhodobé neprerusované zobrazenf
nehybného nebo statického obrazu mdze
zpUsobit ,,vypdleni* obrazovky, rovnéz
zndmé jako ,,dosvit" nebo ,zobrazenf
duchd”. ,Vypdlenf*, ,dosvit" nebo
,,zobrazenf duch(" je dobre zndmy jev
u technologie paneld LCD. V mnoha
pripadech ,vypdleni, ,dosvit"* nebo
,,zobrazeni duchd" postupné zmizf po urcité
dobé mimo provoz.

*  Pred ponechdnim monitoru bez dozoru
vzdy aktivujte spofi¢ obrazovky.

* Bude-li na vasem monitoru LCD zobrazen
nemeénici se staticky obsah, vzdy aktivujte
aplikaci pro pravidelnou obnovu obrazovky.

*  Védzné priznaky ,vypdleni”, , dosvitu" nebo
,,zobrazenf duchd'" nezmizf a nelze je
opravit. Na vySe uvedené poskozeni se
nevztahuje zdruka.

Obraz je zdeformovany. Text je nejasny nebo

rozmazany.

* Nastavte rozliseni zobrazenf pocitace na
stejny rezim, v jakém se nachdzl doporucené
nativni rozlieni obrazovky monitoru.

Na obrazovce se objevuji zelené, cervené,
modré, tmavé a bilé tecky
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*  Zbyvajicl body jsou normalnf viastnostl
tekutych krystall pouZivanych soucasnou
technologif. DalSf podrobnosti viz pravidla
pro obrazové body.

Svétlo indikatoru ,,napajeni* je prilis silné a rusi
* MdZete nastavit intenzitu svétla indikdtoru
,napdjeni" v ¢asti Power LED (Indikdtor
LED napdjeni) v &asti Setup (Nastaven)
v OSD Main Controls (Hlavni ovlddaci prvky
nabidky OSD).

Potrebujete-li dalsi pomoc, viz seznam
Informacni strediska pro zdkazniky a kontaktujte
zastupce sluzeb pro zdkazniky spole¢nosti Philips.

9.2 SmartControl Lite — casté dotazy

OTAZKA 1: Zménil jsem monitor v poéitadi za
jiny a technologie SmartControl
Lite se stala nepouzitelnou, co mam
délat?

Restartujte pocitac a zjistéte, zda
technologie SmartControl Lite
funguje.V opacéném pripadé bude
treba odebrat a znovu nainstalovat
SmartControl Lite, aby bylo zajisténo,
Ze je nainstalovan spravny ovladac.

Odpovéd:

OTAZKA 2: Technologie SmartControl Lite
drive dobre fungovala, ale nyni
nefunguje, co mam délat?
Odpovéd:  Pokud byly provedena ndsledujici
kroky, bude pravdépodobné nutné
znovu nainstalovat ovlada¢ monitoru.
+ PouZijte jiny graficky adaptér videa

» Zaktualizujte ovladac videa

+  Cinnosti na opera¢nim systému, napiklad
aktualizace nebo oprava

*  Spustte sluzbu Aktualizace Windows a
zaktualizujte ovlada¢ monitoru a/nebo videa

*  Operacni systém Windows byl zaveden, kdyz
byl monitor vypnuty nebo odpojeny.

*  Chcete-li ziskat dal3i informace, klepnéte
pravym tlacitkem mysi na My Computer (Tento
pocitac) a klepnéte na Properties (Vlastnosti)
-> Hardware (Hardware) -> Device Manager
(Sprédvce zarizen).



Pokud je pod polozkou Monitor uvedeno ,,Plug
and Play Monitor" (Monitor Plug and Play),

je tfeba provést novou instalaci. Jednoduse
odeberte a znovu nainstalujte SmartControl
Lite.

OTAZKA 3: Kdyz po nainstalovéni

SmartControl Lite klepnu na kartu
SmartControl Lite, ani po chvili

se nic nezobrazi nebo se zobrazi
zprava o chybé, co se stalo?

Odpovéd: V&3 graficky adaptér pravdépodobné

neni kompatibiln{ s technologif
SmartControl Lite. Pokud je

vas graficky adaptér mezi vyse
uvedenymi znackami, zkuste
stahnout nejaktudlnéjsi ovladac
grafického adaptéru z webovych
strdnek prislusného vyrobce.
Nainstalujte ovladac¢. Odeberte a
znowu nainstalujte SmartControl
Lite.

Pokud presto nefunguje, graficky
adaptér bohuzel neni podporovdn.
Na webovém serveru spole¢nosti
Philips zjistéte, zda je k dispozici
zaktualizovany ovlada¢ SmartControl
Lite.

OTAZKA 4: Po klepnuti na Product Information

(Informace o produktu) se zobrazi
pouze ¢astecné informace, co se
stalo?

Odpovéd:  Pravdépodobné nemite k dispozici

nejaktudingsi verzi ovladace
adaptéru grafické karty, kterd piné
podporuje rozhrani DDC/CI.
Pokuste se stédhnout nejaktudingjst
ovlada¢ grafického adaptéru

z webovych stranek prislusného
vyrobce. Nainstalujte ovladac.
Odeberte a znovu nainstalujte
SmartControl Lite.

Attention

Theft mode enabled
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OTAZKA 5: Zapomnél jsem svij kéd PIN pro
funkci zabezpeceni proti kradezi.
Co mam délat?

Odpovéd:  Servisnf stredisko Philips md pravo
zadat legitimni identifikaci a ovérenf
pro zjistén( vlastnictvi monitoru.
Upozormiujeme vds, Ze funkce
ochrany proti krddeZi je k dispozici
jako snadnd a bezplatnd moznost.
Za spravu Cisel PIN nese vyhradnf
odpovédnost konkrétni osoba nebo
organizace, kterd ji jmenuje.

Pokud ¢islo PIN zapomenete,
servisni sti'edisko Philips jej mdze
pro vds znovu nastavit za nomindlnf
poplatek po ovérenf viastnictvi.
Upozormiujeme Vds, Ze na tuto
¢innost se nevztahuji podminky
standardnf zaruky.

9.3 Obecné casté dotazy

OTAZKA 1: Kdyz nainstaluji svij monitor, co
mam udélat, kdyz se na obrazovce
zobrazi zprava ,,Cannot display this
video mode* (Tento rezim videa
nelze zobrazit)?

Odpovéd:  Doporucené rozlisen pro tento
monitor: 1920 x 1080 pri 60 Hz.

»  Odpojte viechny kabely, potom pripojte

pocita¢ k monitoru, ktery jste pouzili predtim.

* V nabidce Start operacniho systému Windows
vyberte Settings/Control Panel (Nastaveni/
Ovlddaci panely). V okné Control Panel
(Ovladac( panely) vyberte ikonu Display
(Zobrazeni). Na panelu Display Control
(Zobrazeni — vlastnosti) vyberte kartu
,Settings' (Nastaveni). Na karté nastaven(

v poli oznaceném ,,desktop area" (pracovnf
plocha) presurite posuvnik na 1920 x 1080
obrazovych bodu.

*  Klepnéte na,,Advanced Properties' (Upresnit),
nastavte polozku Refresh Rate (Obnovovact
frekvence) na 60 Hz a potom klepnéte na OK.

*  Restartujte pocitac a zopakovanim kroku 2 a
3 ovérte, zda je pocita¢ nastaven na 1920 x
1080 pri 60 Hz.

*  Vypnéte pocitac, odpojte stary monitor a
znowu pripojte monitor LCD Philips.

*  Zapnéte monitor a potom zapnéte pocitac.



OTAZKA 2:

Odpovéd:

OTAZKA 3:

Odpovéd:

OTAZKA 4:
Odpovéd:

OTAZKA 5:

Odpovéd:

OTAZKA 6:

Odpovéd:

Jaka je doporucena obnovovaci
frekvence monitoru LCD?
Doporucend obnovovaci frekvence
u monitort LCD je 60 Hz. V pripadé
jakéhokoli ruseni na obrazovce ji
muzete nastavit na 75 Hz a uvidite,
zda rusen( zmizi.

Co jsou soubory .inf a .icm na disku
CD-ROM? Jak Ize nainstalovat
ovladace (.inf a .icm)?

Jedna se o soubory ovladace
monitoru. Pri instalaci ovladacl
postupujte podle pokyn( v
uzivatelské prirucce. Pri prvnf instalaci
bude pocita¢ pravdépodobné
pozadovat ovladace monitoru
(soubory .inf a .icm) nebo disk s
ovladaci. Postupujte podle pokynl a
vlozte (doprovodny disk CD-ROM),
ktery je soucdsti této sady. Ovladace
monitoru (soubory .inf a .icm)
budou nainstalovany automaticky.

Jak mam upravit rozliseni?
Dostupna rozliseni urcuje graficka
karta/ovladac grafiky a monitor.
Pozadované rozliseni mdzete vybrat
v casti Control Panel (Ovlddacf
panely) systému Windows® v &sti
,Display properties” (Zobrazenf -
vlastnosti).

Co kdyz se béhem nastaveni
monitoru ztratim prostrrednictvim
nabidky OSD?

Jednoduse stisknéte tlacitko OK a
potom volbou ,,Reset" (Obnovit)
obnovte viechna plvodni nastavenf
vyrobce.

Je obrazovka LCD odolna proti
poskrabani?

Obecné se doporucuje nevystavovat
povrch panelu nadmémym uderim
a chrénit jej pred ostrymi nebo
tupymi predméty. Pri manipulaci

s monitorem nevyvijejte na povrch
panelu zddny tlak ani silu. Mohlo by
to negativné ovlivnit vase zarucnf
podminky.
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OTAZKA 7: Jak Ize &istit povrch monitoru
LCD?

Odpovéd:  Pro bézné cisténl pouzijte Cisty
a mékky hadrik. Pro dukladné
cisténi pouzijte izopropyl
alkohol. Nepouzivejte zddnd jind
rozpoustédla, jako etylalkohol,
etanol, aceton, hexan atd.

OTAZKA 8: Lze ménit nastaveni barev
monitoru?

Odpovéd:  Ano, nastaveni barev mizete zménit
prostrednictvim nabidky OSD podle
nasledujicich krokd:

»  Stisknutim tlacitka ,,OK" zobrazte nabidku

OSD.

«  Stisknutim tlacftka , Sipka dolii” vyberte volbu
,Color" (Barva) a stisknutim tlacitka ,, OK"
prejdéte na nastaveni barev. K dispozici jsou tfi
nastaven (viz nize).

1. Color Temperature (Teplota barev):
Pri nastaven( v rozsahu 6500K vypadajf
barvy na panelu ,teplé" s ¢ervenobilym
barevnym ténem, zatimco pri nastaveni
teploty 9300K vypadaji barvy na panelu
,studené” s modrobilym barevnym ténem.

2. sRGB: standard pro zajisténi spravné
prrenosu barev mezi riznymi zar{zenimi
(napr:. digitalni fotoapardty, monitory,
tiskdrny, skenery atd.)

3. User Define (Uzivatelské): uzivatel si mze
zvolit vlastni nastaveni barev upravenim
cervené, zelené a modré slozky.

€& Poznamka:

Méreni svétla barvy, které vyzaruje predmét pri
zahrivani. Toto mérenf je vyjadeno v absolutnim
méritku (stupné Kelvina). Nizsi teploty Kelvina,
napriklad 2004 K; jsou cervené; vyssi teploty, jako
napriklad 9300 K, jsou modré. Neutrdlni teplota je
bild pri 6504 K.

OTAZKA 9:  Lze pfipojit tento monitor LCD
k libovolnému poéitaci, pracovni
stanici nebo pocitaci Mac?

Odpovéd: Ano.Vsechny monitory LCD
Philips jsou pIné kompatibilni se
standardnimi pocitaci, pocitaci
Mac a pracovnimi stanicemi. Pro



9. Odstranovani problému a ¢asté dotazy

OTAZKA 10:

Odpovéd:

OTAZKA 11:

Odpoved:

D Vystraha

pripojeni monitoru k systému
Mac mUze byt zapotrebi kabelovy
adaptér. Daldi informace vam

zastupce Philips.

Jsou monitory Philips LCD
vybaveny technologii Plug-and-
Play?

Ano, tyto monitory jsou
kompatibilni s technologii Plug-
and-Play v operacnim systému
Windows 7, Vista, XB NT, Mac
OSX a Linux.

Co znamena |péni obrazu,
vypaleni obrazu, dosvit nebo
,,duch v souvislosti s panely
LCD?

Dlouhodobé neprerusované
zobrazeni nehybného nebo
statického obrazu mdze zpGsobit
,Vvypaleni" obrazovky, rovnéz
znamé jako ,,dosvit"* nebo
,zobrazenf duchd”. , Vypdlen*,
,dosvit" nebo ,zobrazenf duchd"
je dobre znamy jev u technologie
panell LCD.V mnoha pripadech
,Vypaleni”,, dosvit" nebo
,zobrazenf duchd" postupné zmizf
po urcité dobé mimo provoz.
Pred ponechdnim monitoru bez
dozoru vzdy aktivujte sporic
obrazovky.

Bude-li na vasem monitoru LCD
zobrazen neménicf se staticky
obsah, vzdy aktivujte aplikaci pro
pravidelnou obnovu obrazovky.

Vdzné priznaky ,vypdleni, , dosvitu" nebo
,,zobrazeni duchd" nezmizi a nelze je opravit. Na

vySe uvedené poskozeni se nevztahuje zaruka.
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OTAZKA 12: Proé se na displeji nezobrazuje

Odpovéd:

ostry text a pro¢ maji
zobrazené znaky zubaté okraje?
V43 monitor nejlépe pracuje pri
svém nativnim rozlisenf 1920

x 1080 pri 60 Hz. PouZivejte
toto rozlisenf pro dosazenf
optimdlniho zobrazenf.
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